[image: image247.png]


[image: image248.jpg]=1 Office




[image: image249.png]


[image: image250.png]



2007 Microsoft Office System User Interface Design Guidelines

	2007 Microsoft® Office sYSTEM User Interface Design Guidelines

	Guidelines for Licensing the 2007 Microsoft Office System User Interface
For Evaluation Only



MICROSOFT EVALUATION LICENSE

2007 MICROSOFT  OFFICE SYSTEM USER INTERFACE ___________________________________________________________

This license grants you certain rights to review the attached Design Guidelines.  By reviewing the attached Design Guidelines, you agree to the terms of this license.  This license is an agreement between Microsoft Corporation (“Microsoft”) and you.  

1.
License grantS.    If you comply with this agreement, Microsoft grants you a non-exclusive license to evaluate the Design Guidelines solely for purposes of determining whether to enter into a license agreement with Microsoft for rights to develop products using the 2007 Microsoft® Office System User Interface.

2.
CONFIDENTIALITY.  The Design Guidelines, and the terms of this Agreement, are Microsoft’s confidential information.  You cannot disclose them to anyone else without Microsoft’s prior written approval.  However, you may disclose them to your contractors who have a need to know as long as they also agree to abide by the terms of this agreement.    

3.
RESTRICTIONS.  The Design Guidelines are for reference only and may not be used in development.  You agree that you will destroy the Design Guidelines within thirty (30) days after you first acquire them or upon termination, whichever is earlier.  
4.
RESERVATION OF RIGHTS.  Microsoft reserves all rights not expressly granted in this agreement.  No additional rights (including any implied licenses) are granted by implication, estoppel or otherwise.  

5.
FEEDBACK.  You have no obligation to give Microsoft any feedback relating to the Design Guidelines.  If you give any feedback, you agree that Microsoft may incorporate it into the Design Guidelines.  You also agree that Microsoft may incorporate the feedback in its products and allow others to use it when developing their products.  You will not give Microsoft any feedback that you do not have the right to provide under these terms.

6.
DISCLAIMER OF WARRANTIES.  THE DESIGN GUIDELINES ARE PROVIDED “AS IS.” 

7.
APPLICABLE LAW.  The laws of the State of Washington govern this agreement.  If federal jurisdiction exists, we each consent to jurisdiction and venue in the federal courts in King County, Washington.  If not, we each consent to jurisdiction and venue in the Superior Court of King County, Washington. 
8.
ASSIGNMENT.  This agreement is non-transferable.
9.
TERMINATION.  This agreement terminates thirty (30) days from the date you acquire the Design Guidelines or upon breach.  Sections 2-8 of this Agreement will survive its termination.  
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Introduction
The 2007 Microsoft Office System provides a new user interface for productivity software.  This document contains the implementation requirements for licensing the 2007 Microsoft Office User Interface (2007 Microsoft Office UI).  The requirements outlined in this document are the same for both client and web-based applications.

Who Should read this document?
This document should be read by developers, independent software vendors, and component vendors who are interested in licensing or who have licensed the 2007 Microsoft Office UI. 
DISCLAIMER: The 2007 Microsoft Office UI SHOULD NOT be implemented for websites or web-based applications whose primary purpose is to enable browsing, purchasing, or downloading content.  The 2007 Microsoft Office UI was NOT developed to address these user tasks. 
Definitions 
The key words "MUST", "MUST NOT", "REQUIRED", “NOT REQUIRED”, "SHALL", "SHALL NOT", "SHOULD", "SHOULD NOT", "RECOMMENDED", and "OPTIONAL" in this document have the meanings below:
1. The words MUST, REQUIRED and SHALL, indicate absolute requirements of the Design Guidelines.
2. The phrases MUST NOT and SHALL NOT indicate absolute prohibitions of the Design Guidelines.
3. The words SHOULD and RECOMMENDED and the phrase NOT REQUIRED mean you must carefully weigh the full implications before choosing a different course.
4. The phrases SHOULD NOT and NOT RECOMMENDED mean you must carefully weigh the full implications before implementing this behavior.
Implementation Requirements
1. If you choose to implement these guidelines, you MUST include this notice in your product:  The 2007 Microsoft Office User Interface is subject to protection under U.S. and international intellectual property laws and is used by [LICENSEE NAME] under license from Microsoft.
2. The 2007 Microsoft Office UI consists of the following thirteen elements: Application Menu, Ribbon, Tabs, Groups, Controls, Ribbon Resizing, Quick Access Toolbar, Visual Appearance, Keyboard Access, Contextual Tabs, Galleries, Mini Toolbar, and ScreenTips.  
3. All nine of the following required elements MUST be implemented if any one of the elements is implemented: Application Menu, Ribbon, Tabs, Groups, Controls, Ribbon Resizing, Quick Access Toolbar, Visual Appearance, and Keyboard Access.

4. The following four optional elements are NOT REQUIRED: Contextual Tabs, Galleries, Mini Toolbar, and ScreenTips.  If any one of these four optional elements is implemented, then all nine of the required elements MUST be implemented (i.e., Application Menu, Ribbon, Tabs, Groups, Controls, Ribbon Resizing, Quick Access Toolbar, Visual Appearance, and Keyboard Access).

5. If you create a utility with minimal functionality, which only appears within a licensed application that has implemented all nine required elements, then your utility may include only the Application Menu and Quick Access Toolbar, so long as the overall look of the utility is consistent with the Application Menu, Quick Access Toolbar, and Visual Appearance sections of these Design Guidelines.
6. If your application requires additional controls or navigation elements that are not described in these Design Guidelines, they MUST be designed to be compatible with the 2007 Microsoft Office UI interaction model and the overall visual appearance embodied in these Design Guidelines.
7. The Microsoft Office Transformer Logo and the decorative background arc pictured below are branding elements reserved by Microsoft.  You MUST NOT include them in your Licensed UI or Licensed Products (whether or not they appear in the contextual screenshot examples in any particular section of these guidelines).  

Microsoft Office Transformer Logo:
[image: image1.emf]


Decorative Background Arc:
[image: image2.emf]


Additional Resources
1. Document Location: http://msdn.microsoft.com/officeui 

2. Questions Regarding Implementation Requirements: officeui@microsoft.com
3. Jensen Harris: An Office User Interface Blog: http://blogs.msdn.com/jensenh/
4. 2007 Microsoft Office System UI Extensibility: http://msdn.microsoft.com/office/tool/ribbon/
Application Menu (Required)
The Application Menu appears when users click the Application Button in the upper-left corner of the window.  This menu displays controls used to perform actions on the entire document, like Save, Print, and Send.  The Application Menu also provides a list of recent documents, access to application options for changing user settings and preferences, and application exit. 

[image: image3.emf]


NOTE:  All figures in this document are for illustrative purposes only.
Requirements for the Application Menu

The Application Menu requirements outlined below MUST be implemented if any of the following elements of the 2007 Microsoft Office UI are implemented: Ribbon, Tabs, Groups, Controls, Ribbon Resizing, Quick Access Toolbar, Visual Appearance, or Keyboard Access.  For more details see the Implementation Requirements.
Displaying the Application Menu

1. The Application Button MUST be displayed in the upper-left corner of the application window.  (Note in the figure below the Application Button is located in the upper-left corner of the application window.)
[image: image4.emf]


2. The Application Button MUST NOT be a part of the Ribbon Tabs or the Quick Access Toolbar.

3. Clicking the Application Button MUST display the Application Menu.  

4. The Application Menu MUST display controls for performing actions on the entire document like New, Open, Save, Save As, Print, Send, and Close.

5. The Application Menu MUST have two vertical panes.

6. The left pane MUST be able to display controls for performing actions on the entire document.  
7. The right pane SHOULD display a list of recent documents if applicable.  

8. The width of the Application Menu SHOULD be fixed.  It SHOULD NOT change when the length of the file names displayed in the recent documents changes.

9. The height of the Application Menu MUST be no larger than the size required to display the controls listed.  Additional empty space MUST NOT be displayed at the bottom of the left pane of the Application Menu.

10. Vertical scrollbars MUST NOT be displayed for either the left or right pane of the Application Menu.

Application Menu Controls

1. The Application Menu MUST be able to display four types of controls: menus, galleries, split-buttons, and buttons.  

2. The Application Menu is NOT REQUIRED to display all four types of controls if they are not applicable.

3. Menu controls displayed on the Application Menu SHOULD automatically open when the mouse pointer hovers over the menu anchor for more than 300 ms.  (Note in the figure below the items in the “Send a copy of the document to other people” menu are automatically displayed when the mouse pointer is over the Send menu anchor for more than 300 ms.)
[image: image5.emf]


4. Menu items MUST be displayed over the right pane of the Application Menu. 
5. Menu items MUST be aligned with the top of the Application Menu.  The menu items MUST NOT be aligned with the top of the of the menu anchor.

6. Menu items MUST completely occlude the right pane of the Application Menu, regardless of the number of items available in the menu options.  (Note in the figure below the menu options completely occlude the right pane of the Application Menu, even though there are only four items displayed in the menu options.)
[image: image6.emf]


7. Menu options SHOULD be no larger than the right pane of the Application Menu.  Menu options SHOULD NOT extend outside the Application Menu.

8. If there are more items in the menu than can be displayed in the vertical space available, then a scroll button MUST appear at the bottom of the menu.  (Note in the figure below the scroll button at the bottom of the menu options.)
[image: image7.emf]


9. Horizontal scroll bars MUST NOT be displayed for menu items.

10. Split buttons are NOT REQUIRED for the Application Menu.

11. If split buttons are displayed on the Application Menu, then the menu portion of split buttons MUST automatically open when the mouse pointer hovers over any part of the split button for more than 300 ms.

12. Menu items MUST be displayed when users hover over either the menu or the button portion of a split button displayed on the Application Menu.  Users MUST NOT be required to hover over the menu portion of the split button for the menu items to be displayed.  (Note in the figure below the items in the “Save a copy to the document” menu are displayed when a user hovers over the button portion of the Save As split button control.)
[image: image8.emf]


Ribbon (Required) 
The Ribbon is the primary replacement for menus and toolbars in the 2007 Microsoft Office UI.  The Ribbon MUST contain the following three elements:
1. Tabs.  Tabs are used to organize controls in the Ribbon around the core scenarios and tasks that users perform with the application. 
2. Groups.  Each tab contains one or more groups which show related controls together.
3. Controls.  Different types of controls can be hosted in the Ribbon.  Examples of controls are menus, split buttons, combo boxes, and spinner controls.
[image: image9.emf]


Requirements for the Ribbon
1. The Ribbon MUST replace all top-level menus and toolbars (e.g. File, Edit, View, Insert, Window, etc.).
2. The Ribbon MUST NOT coexist with top-level menus and toolbars.  The Ribbon is a replacement for menus and toolbars.  The Ribbon is not an additional component that can be added onto an existing menu-and toolbar-based user interface. 
3. The Ribbon MUST contain all three of the following elements: tabs, groups, and controls.
4. The Ribbon MUST be positioned at the top of the application window in a space that is dedicated to displaying the Ribbon.  
5. The Ribbon MUST NOT be displayed on either side of the application window or at the bottom of the application window.
6. The Ribbon MUST NOT be able to float over the document workspace so that users can drag the Ribbon and position it wherever they want.
7. Users MUST NOT be able to dock the Ribbon on either side of the application window or at the bottom of the application window.
8. The Ribbon MUST NOT be displayed over the top of the document by default.  (See Minimizing the Ribbon for more information.) 
9. The Ribbon MUST NOT auto-hide/appear when the mouse pointer moves away from/towards the top edge of the application window.
10. The Ribbon MUST NOT display any application logos or images that cannot be clicked or that are not part of a control.
11. The Ribbon MUST extend the full width of the application window at all times.  The Ribbon MUST resize in the horizontal direction when the application window is resized.  The Ribbon MUST NOT resize in the vertical direction when the application window resizes.  (See Ribbon Resizing for more information.)
12. Users MUST NOT be able to resize the Ribbon.  
13. Resize handles MUST NOT appear anywhere on the Ribbon.  The Ribbon MUST only resize in the horizontal direction when the application window is resized.
14. The Ribbon MUST be exactly tall enough to display three vertically stacked controls that use 16x16 pixel icons at 96 dpi.  (Note the height of the Ribbon in the Figure below.)
[image: image10.emf]


15. The Ribbon MUST NOT be any taller than the height required to display three vertically stacked controls that use 16x16 pixel icons at 96 dpi.
Tabs (Required)
Tabs are used to organize controls in the Ribbon around the activities that users perform in the application.  For this reason, every application will have a unique set of tabs which correlate to the activities that users perform with that particular application.  The one exception to this rule is the leftmost tab, which MUST include the controls used to accomplish the most frequently-performed actions with the application and SHOULD be labeled “Home.”  
[image: image11.emf]


Requirements for Tabs
The Tab requirements outlined below MUST be implemented if any of the following elements of the 2007 Microsoft Office UI are implemented: Application Menu, Ribbon, Groups, Controls, Ribbon Resizing, Quick Access Toolbar, Visual Appearance, or Keyboard Access.  For more details see the Implementation Requirements.

Displaying Tabs
1. The leftmost tab (the “Home” Tab) MUST be selected every time the application is started.  
2. The tab that was selected in the Ribbon when the application was last closed MUST NOT be selected when the application is next started.
3. Clicking a tab MUST select that tab and display the controls on the Ribbon for that tab.
4. The tab selected on the Ribbon MUST NOT automatically switch as a result of user selections made in the document (except as noted in the Contextual Tabs section).
5. The controls displayed MUST be for only one tab on the Ribbon at a time.  
6. Users MUST NOT be able to select more than one tab at a time.
7. Tabs MUST be displayed only on one row across the top of the Ribbon.  Tabs MUST NOT be displayed on more than one row on the Ribbon.  (See Ribbon Resizing for details on how to display tabs when the width of the application window is small.) 
8. The height of tabs MUST NOT change when you switch tabs.  
9. The width of tabs MUST vary with the length of the tab label.  Tabs with long names MUST be wider than tabs with short names.  (Note in the Figure below the Insert and Page Layout Tabs are the same height, but the Page Layout Tab is wider than the Insert Tab.)
[image: image12.emf]


10. Selecting a tab MUST NOT change the height or width of that tab.
11. The width of each tab MUST include a uniform amount of padding on each side of the text label to provide the space necessary for displaying REQUIRED tab states like mouse hover and selected.  (See the Visual Appearance section for more details.)  
Minimizing the Ribbon
Users SHOULD be able to minimize the Ribbon.  The requirements outlined below are REQUIRED if minimizing the Ribbon is implemented.

1. The Ribbon MUSTx be minimized when users double-click the currently selected Tab, choose “Minimize the Ribbon” from the Tab right-click menu, or type CTRL+F1.  (Note the minimized Ribbon in the Figure below.)
[image: image13.emf]


2. The tabs MUST be the only parts of the Ribbon that are displayed when the Ribbon is minimized.
3. The Ribbon MUST remain minimized until users either double-click a Tab, unselect “Minimize the Ribbon” from the Tab right-click menu, or type CTRL+F1.
4. The Ribbon MUST NOT be automatically displayed when the mouse pointer hovers over the tabs.
5. There MUST NOT be a tab selected when the Ribbon is minimized.
6. Clicking on any tab MUST display the controls on the Ribbon for that tab over the document workspace.  (Note in the figure below the Ribbon is displayed over the document workspace [B], rather than shifting the workspace down, when the user clicks the Home Tab.)
	A
	[image: image14.emf]



	B
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7. The Ribbon MUST continue to be displayed regardless of the location of the mouse pointer.  The Ribbon MUST NOT automatically close/open when the mouse pointer moves away from/towards the top of the Ribbon.
8. The Ribbon MUST return to the minimized state after a control on the Ribbon or an item from a menu is chosen.
9. The Ribbon MUST return to the minimized state when users click anywhere other than a control displayed on the Ribbon.
10. Clicking below the Ribbon on the document workspace MUST NOT dismiss or clear the current selection of objects or text in the document.

11. The Ribbon MUST be minimized when the application is opened if the Ribbon was minimized when the application was last closed.
12. The Ribbon MUST NOT be minimized when the application is opened for the very first time.
Tab Scrolling
Users SHOULD be able to use the mouse scroll wheel to navigate from one Tab to another when the mouse pointer is over the Ribbon.  The requirements outlined below are REQUIRED if Tab Scrolling is implemented.  (See Keyboard Access for information on how to navigate the Ribbon without a mouse.)  
1. The mouse pointer MUST be over the Ribbon for tab scrolling to be enabled.
2. Scrolling down with the mouse scroll wheel MUST navigate to the tab on the right of the currently selected tab.  Scrolling up MUST navigate to the tab on the left of the currently selected tab.
3. Scrolling the mouse wheel  MUST navigate to the next tab regardless of what control on the Ribbon the mouse pointer is over.  Only when mouse focus is in a control will the mouse scroll wheel work for that control.
4. Scrolling MUST NOT wrap around from the last tab on the right to the first tab on the left or vice versa.  (Note that the View Tab is selected in the figure below.  Scrolling down with the mouse scroll wheel MUST NOT navigate to the Home Tab.)
[image: image16.emf]


5. Scrolling MUST NOT be enabled when the Ribbon is minimized.
Best Practices for Tabs
1. The number of tabs SHOULD be kept small to afford browsing and learning.  Roughly five to nine tabs is the rule of thumb.  
2. Each control SHOULD exist on only one tab in the Ribbon.  Controls SHOULD NOT be repeated on more than one tab in the Ribbon whenever possible, since this makes it easier for users to learn the location of controls in the Ribbon more quickly.
3. Successful implementation of the 2007 Microsoft Office UI relies on a deep and accurate understanding of the core activities performed with the application.  The frequency of use for controls and the sequence of controls used to perform core activities SHOULD be used to determine what controls to place in each tab in order to minimize tab switching.  Controls frequently used together SHOULD be placed on the same tab to minimize the need for switching between tabs while performing core activities with the application.  
4. Users SHOULD be able to perform most basic activities within the application by using only the controls on the Home Tab.  
5. The most frequently used controls SHOULD be placed on the Home Tab to minimize tab switching.
6. Frequency of use SHOULD NOT be the sole determinant when deciding what controls to display on the Home Tab.  For example, the Insert Picture control in Microsoft Word is one of the most frequently used controls in the application.  However, that control clearly belongs on the Insert Tab and not on the Home Tab since that location for the control more closely aligns with the logical organization of the tabs in the application.  
Groups (Required) 
Groups are used to organize related controls on a tab in the 2007 Microsoft Office UI.  They make it easier to browse the Ribbon by formalizing the relationship among controls on a particular tab.  Groups also make it easier to find controls that are not located on the Ribbon by using Dialog Box Launchers to provide quick access to less commonly used controls with closely related functionality.  The Dialog Box Launcher can be clicked to open a related dialog box or task pane with more advanced functionality related to the group.
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Requirements for Groups
The Groups requirements outlined below MUST be implemented if any of the following elements of the 2007 Microsoft Office UI are implemented: Application Menu, Ribbon, Tab, Controls, Ribbon Resizing, Quick Access Toolbar, Visual Appearance, or Keyboard Access.  For more details see the Implementation Requirements.

Displaying Groups
1. Controls MUST be organized into groups. 
2. Every control on the Ribbon MUST be displayed in a group, even when there is only one control in the group. 
3. Controls displayed in a group MUST NOT change as a result of selection.  If a control is not active, then the control MUST be grayed out, rather than removed from the group.  This provides a more predictable user experience and prevents the layout of controls on the Ribbon from changing and distracting users.
4. Every group MUST have a label.  
5. Group labels MUST be as short and descriptive as possible.
6. Group labels MUST NOT change as a result of selection.
7. Group labels MUST be positioned below the group and horizontally centered.  (Note in the figure below “Page Setup” is centered in the available space.)
[image: image18.emf]


8. Group labels MUST have a background color that is visually distinct from the background color of the group.
9. The background color for group labels MUST extend the entire width of the group.  (Note in the figure below the dark blue color for the Pages Group extends the entire width of the group.)
[image: image19.emf]

  
10. The group label MUST be displayed at all times and MUST NOT appear or disappear when the mouse pointer hovers over the Ribbon.
11. Groups SHOULD have two states: normal and hover.  The hover state SHOULD be independent of the hover state for controls within the group.  The table below describes the two group states that are OPTIONAL for the 2007 Microsoft Office UI. 
	[image: image20.emf]


	Normal.  The group is drawn with a default background color.  This state is also referred to as the “rest” state.  

	[image: image21.emf]


	Hover.  The group and group label are drawn with a background color that is slightly lighter than their normal states to provide a glow effect.  
The visual appearance of controls in the group SHOULD NOT change.  Only the background color for the group SHOULD change.  
The group hover state SHOULD persist when the mouse hovers over controls in the group, but the controls in the group SHOULD have an independent hover state that is only displayed when the mouse hovers over the control.


Dialog Box Launchers 
1. Groups MUST be able to display Dialog Box Launchers.
2. Dialog Box Launchers are NOT REQUIRED for every group.  
3. Every dialog box in the application is NOT REQUIRED to map to a Dialog Box Launcher.  Many dialog boxes SHOULD NOT map to a Dialog Box Launcher.  Dialog Box Launchers SHOULD be used only to access dialog boxes that provide more advanced functionality related to the group.
4. Dialog Box Launchers MUST be represented as a small, diagonal arrow in the lower-right corner of the group.  (See the Dialog Box Launcher in the lower-right corner of the Font group in the figure below.)
[image: image22.emf]


5. Dialog Box Launchers MUST NOT execute a command that modifies a selection in the document.  Dialog Box Launchers MUST only provide access to additional controls by opening a dialog box or task pane.
6. The group label MUST NOT behave like a hyperlink.  Clicking on the group label MUST NOT open the dialog box for that group.
7. Dialog Box Launchers MUST have two states: normal and hover.  The hover state MUST be independent of the group hover state.  The table below describes the two Dialog Box Launcher states REQUIRED for the 2007 Microsoft Office UI.  
	[image: image23.emf]


	Normal.  The Dialog Box Launcher is displayed with a default background color.  This state is also referred to as the “rest” state.  

	[image: image24.emf]


	Hover.  The Dialog Box Launcher is displayed with the glow color used to indicate hover on controls in the 2007 Microsoft Office UI.  
The hover state for Dialog Box Launchers is independent of the hover state for groups.  


Best Practices for Groups
1. The number of groups on a tab SHOULD be kept small to afford browsing and learning.  Roughly four to seven groups per tab is the rule of thumb.  
2. Controls frequently accessed via Dialog Boxes SHOULD be displayed on the Ribbon to reduce the frequency with which users are required to open dialog boxes.  
3. In most cases, controls displayed on the Ribbon SHOULD NOT simply launch dialog boxes.  Controls displayed on the Ribbon SHOULD instead use Galleries whenever possible to provide results-oriented choices.

Controls (Required)
The Ribbon MUST be able to display several types of controls.  These controls include, but are not limited to, buttons, menus, split buttons, combo boxes, Galleries, spinner controls, and check boxes.  In addition, the Ribbon can display both a large and small version of many controls.  By using a combination of large and small controls organized into groups, the relative importance and the relative relationship among controls on the Ribbon is visually conveyed to the user.  This arrangement of controls makes it easy for users to browse the Ribbon and discover new functionality.   
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Requirements for Controls
The Controls requirements outlined below MUST be implemented if any of the following elements of the 2007 Microsoft Office UI are implemented: Application Menu, Ribbon, Tab, Groups, Ribbon Resizing, Quick Access Toolbar, Visual Appearance, or Keyboard Access.  For more details see the Implementation Requirements.

Displaying Controls
1. The Ribbon MUST be able to display a variety of controls that include, but are not limited to, buttons, split buttons, combo boxes, Galleries, menus, spinners, and check boxes.

2. Custom controls SHOULD be implemented to be consistent with the overall visual appearance and behavior of the 2007 Microsoft Office UI.  Standard Microsoft Windows controls displayed on the Ribbon, MUST follow the Windows XP or Windows Vista Theme.  Windows 95 (“classic style”) controls MUST NOT be displayed on the Ribbon.

3. The Ribbon MUST be able to display text labels for all types of controls.

4. Controls MUST NOT appear/disappear on the Ribbon as a result of selection in the document.
5. Text labels for controls MUST NOT change.  The control MUST simply toggle on/off using the normal and selected control states.
6. Controls MUST be disabled (grayed out) if the criteria required for their activation have not been met.
7. Both the menu and button portion of split button controls MUST be disabled on the Ribbon if all of the items in the menu are inactive.  
Control Layouts
1. The Ribbon MUST be able to display both large and small versions of controls in the same group.  The large version of controls SHOULD use 32x32 pixel icons at 96 dpi.  The small version of controls SHOULD use 16x16 pixel icons at 96 dpi.  (Note in the figure below the large version of the Paste control and the small versions of Cut, Copy, and Format Painter controls.)
[image: image26.emf]


2. The Ribbon MUST be able to display multiple types of controls within the same group.  (Note in the figure below combo boxes, split buttons and small buttons are all displayed in the same group.)
[image: image27.emf]


3. The Ribbon MUST be able to display three vertically stacked small controls.  (Note in the figure below the three small controls are vertically stacked.)
[image: image28.emf]


4. The Ribbon MUST be able to display two vertically distributed controls.  (Note in the figure below the Previous and Next controls are vertically distributed.)
[image: image29.emf]


5. The Ribbon MUST be able to top align two small controls.  (Note in the figure below the Add Text and Update Table controls are top aligned as opposed to vertically distributed.)
[image: image30.emf]


6. The Ribbon MUST be able to display a button group of controls within a group.  (Note in the figure below the button group of controls that include Bold, Italic, and Underline.)
[image: image31.emf]


Control Labels
1. The Ribbon MUST be able to display text labels for all controls.  
2. Large controls displayed in the Ribbon MUST contain text labels.  Large controls MUST NOT be displayed in the Ribbon without text labels.  Only small controls MAY be displayed in the Ribbon without text labels. 
3. Text labels for controls in the Ribbon MUST NOT use ellipses to indicate that a dialog box will be displayed.  (Note in the figure below no ellipses are used for Hyperlink, even thought it launches a dialog box.)
[image: image32.emf]


4. Text labels MUST be centered below the icon of large controls and SHOULD use two lines of text when necessary to keep the width of the control as small as possible.  (Note in the figure below Page Number uses two lines to display the text label.)
[image: image33.emf]


5. Text labels MUST be positioned to the right of the icon of small controls.  Text labels for small controls MUST be left aligned when vertically stacked in the Ribbon.  (Note in the figure below the Find, Replace, and Select text labels are left aligned.)
[image: image34.emf]


6. Menus and split buttons MUST have a dropdown arrow associated with the control.  The dropdown arrow MUST be centered below the label for large controls that require only one line of text.  (Note in the figure below the dropdown arrow is displayed below the text labels for Margins, Orientation, Size, and Columns.)
[image: image35.emf]


7. The dropdown arrow for large menus and toolbars MUST be positioned in line with the second line of text when more than one of text is needed.  (Note in the figure below the dropdown arrow is displayed in line with the second line of text for the Table of Contents control.)
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4. Text labels for small controls MUST NOT use two lines of text.  (Note in the figure below the text for the Update Table control is displayed on one line.)
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5. Six control states SHOULD be represented.  Control states SHOULD include: disabled, normal, hover, pressed, selected, and hover selected.  The table below describes the six control states RECOMMENDED for the 2007 Microsoft Office UI along with examples.
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	Disabled.  Displayed when the control is inactive.
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	Normal.  Displayed when the control is active and the mouse is not over the control.
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	Hover.  Displayed when the mouse is over the control.
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	Pressed.  Displayed when the left mouse button is pressed down.
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	Selected.  Displayed when a control is selected.  Sometimes referred to as the “depressed” state for toggle buttons.
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	Hover Selected.  Displayed when the mouse is over a selected control.


Control Behaviors
1. For large split button controls, clicking on the icon MUST always perform the default action for the control (i.e., either the first item in the menu or the most recently used item from the menu).  Clicking on the text label associated with the dropdown arrow MUST always display the menu.  (Note in the figure below the two parts of the Paste split button.) 
[image: image44.emf]

  
Best Practices for Controls
1. Controls SHOULD exist on only one tab in the Ribbon.  Controls SHOULD NOT be repeated on more than one tab in the Ribbon whenever possible, since this makes it easier for users to learn the location of controls in the Ribbon more quickly.

2. Text labels SHOULD be used whenever possible to describe the control.
3. Text labels for controls SHOULD be kept as short as possible in order to keep the width of the control and thus the group as short as possible.
4. Large and small controls SHOULD be used to visually convey the relative importance or frequency of use for controls displayed within a group.  For example, adjusting the margins in a document is more frequently used than any of the other Controls in the Page Setup group and is therefore displayed using a large control.  (Note in the figure below the Margins control uses a large control, while the remaining commands in the group use small controls.)
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5. For small split buttons, the text label SHOULD be associated with the more frequently-used part of the split button (i.e., button versus menu).  If the button part of the control is most frequently used, then the text label SHOULD be associated with the icon to provide a large target for the mouse.  If the menu part of the split button is most frequently used, than the text label SHOULD be associated with the dropdown arrow to provide a larger target for the mouse.  (Note in the figure below two different implementations for small split buttons.  The text label is associated with the icon in the Reject control, while the text label is associated with the dropdown arrow in the Shape Fill control.  In both cases, the text label is associated with the most frequently-used part of the split button in order to provide a larger target for the mouse.)
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Ribbon Resizing (Required)
The layout of controls in the Ribbon changes when the width of the application window changes.  When displayed on a large monitor, the Ribbon will adjust to show the “large versions” of groups in the Ribbon.  When displayed on a small monitor, or when the user chooses to manually reduce the size of the application window, the Ribbon will adjust to show the “small versions” of groups in the Ribbon.  The Ribbon is not designed for a particular display resolution.  The Ribbon simply provides the best arrangement of the controls for the application and displays that arrangement appropriately for every possible size of the application window.  

The figure below illustrates how the layouts of controls on Microsoft Word’s Insert Tab change when the application window is horizontally resized.  Note that some controls change from being displayed as large controls to being displayed as small controls when the Ribbon is narrower.  Also note that some text labels for controls are removed from the Ribbon when the Ribbon is narrower.
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Requirements for Ribbon Resizing

The Ribbon Resizing requirements outlined below MUST be implemented if any of the following elements of the 2007 Microsoft Office UI are implemented: Application Menu, Ribbon, Tab, Groups, Controls, Quick Access Toolbar, Visual Appearance, or Keyboard Access.  For more details see the Implementation Requirements.

Defining Groups for Ribbon Resizing

1. Resizing the width of the application window MUST change the layout of controls on the Ribbon.

2. The layout of controls on the Ribbon MUST change in real-time when the application window is resized by dragging with the mouse.  The change in the layout of controls on the Ribbon MUST NOT be delayed until after the application window has been resized and the left mouse button is released.

3. Changing the layout of the controls on the Ribbon MUST be achieved by substituting variants for each group that differ in width.  (Note in the figure below two different variants for the Illustrations group that use a different layout for the controls and vary in width.)
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4. Each variant MUST have a unique layout for the controls in the group 

5. Each variant MUST contain all of the controls for the group.  Controls MUST NOT be added or deleted from different variants of the same group.

6. Groups MUST have at least two predefined variants, “Large” and “Collapsed.”  (Note in the figure below the large and collapsed group variants for the Illustrations group.)
	Large 
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	Collapsed 
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7. Groups SHOULD have three – four predefined variants to provide a smooth transition between group variants when the application window is horizontally resized.  The four predefined variants for the Illustrations group are shown in the table below.  (Note how the layout of controls for each variant changes to produce variants of different widths.)
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	Large.  All five controls are displayed using large Icons (32x32 pixels at 96 dpi)
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	Medium.  The first two controls are displayed using large Icons.  The last three controls are displayed using small icons (16x16 pixels at 96 dpt) and are stacked vertically to decrease the width of the group.
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	Small.  The first two controls are displayed using large icons.  The last three controls are displayed using small icons, but the text labels have been dropped to decrease the width of the group.
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	Collapsed.  The group is collapsed into one item that displays the group text label, “Illustrations.”  


Collapsed Group Behavior

1. Collapsed groups MUST use the same text string as the group Label

2. Clicking a collapsed group MUST display the largest variant for that group below the Ribbon if the group does not contain an in-Ribbon gallery.  For groups that contain an in-Ribbon gallery, the smallest variant for that group MUST be displayed below the Ribbon.  (Note in the figure below the collapsed “Page Setup” group is displayed below the Ribbon.)
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3. All controls MUST behave in the same way when they are displayed below the Ribbon from a collapsed group as they do when they are displayed on the Ribbon.

4. Collapsed groups displayed below the Ribbon MUST immediately disappear after a control within it is chosen.

5. Collapsed groups displayed below the Ribbon MUST immediately disappear if the user clicks anywhere outside the group.  

6. Clicking outside a collapsed group displayed below the Ribbon MUST NOT dismiss or clear the current selection of objects or text in the document.

7. For controls that require user input, like spinner controls and combo boxes, the group MUST remain displayed below the Ribbon until the user types ENTER on the keyboard or clicks anywhere outside the group.  (Note in the figure below the collapsed group remains displayed while the user has text selection in the combo box for Indent Left.)
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Defining Group Combinations for Ribbon Resizing

1. Each tab in the Ribbon MUST have several predefined combinations of group variants for a sample of several possible application window widths.  The table below provides a summary of the fifteen predefined group variant combinations for the Insert tab in Microsoft Word.   

	
	
	Group Variants (Large, Medium, Small, Collapsed)

	
	
	Pages
	Tables
	Illustrations
	Links
	Headers & 
Footers
	Text
	Symbols

	Group Combinations for Insert Tab
	1
	Large
	Large
	Large
	Large
	Large
	Large
	Large

	
	2
	Large
	Large
	Large
	Medium
	Large
	Large
	Large

	
	3
	Large
	Large
	Large
	Medium
	Large
	Large
	Medium

	
	4
	Medium
	Large
	Large
	Medium
	Large
	Large
	Medium

	
	5
	Medium
	Large
	Large
	Medium
	Large
	Medium
	Medium

	
	6
	Medium
	Large
	Large
	Medium
	Medium
	Medium
	Medium

	
	7
	Medium
	Large
	Medium
	Medium
	Medium
	Medium
	Medium

	
	8
	Medium
	Large
	Medium
	Medium
	Medium
	Small
	Medium

	
	9
	Medium
	Large
	Medium
	Collapsed
	Medium
	Small
	Medium

	
	10
	Collapsed
	Large
	Medium
	Collapsed
	Medium
	Small
	Medium

	
	11
	Collapsed
	Large
	Medium
	Collapsed
	Medium
	Small
	Collapsed

	
	12
	Collapsed
	Large
	Small
	Collapsed
	Medium
	Small
	Collapsed

	
	13
	Collapsed
	Large
	Collapsed
	Collapsed
	Medium
	Collapsed
	Collapsed

	
	14
	Collapsed
	Large
	Collapsed
	Collapsed
	Collapsed
	Collapsed
	Collapsed

	
	15
	Collapsed
	Large
	Collapsed
	Collapsed
	Collapsed
	Collapsed
	Collapsed


	1
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	2
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	3
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	4
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	5
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	6
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	7
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	8
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	9
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	10
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	11
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	12
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	13
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	14
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	15
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2. When the application window is horizontally resized, the combination of variants that allows the greatest number of groups to be at their largest variants MUST be displayed.
3. If the width of the application window is too large for a combination of group variants to fill the entire Ribbon, then the groups MUST be left aligned in the Ribbon with any remaining empty space displayed on the right.  (Note in the figure below empty space is displayed on the right side of the Ribbon, since there is not enough room to display one of the groups at their next larger size.)
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4. The width of each group MUST be determined by the width of the controls within the group.  The width of each group MUST NOT be determined by the length of the group label.  

5. If the length of the group label is wider than the width of the controls within the group, then the group label MUST be truncated to provide more available space on the Ribbon for other groups to display larger variants.  For this reason, the length of group labels MUST be kept short.  (Note in the figure below the Table of Authorities group label is truncated because the group label is wider than the controls within the Group.)
[image: image77.emf]


6. If empty space is available on the right side of the Ribbon, then the width of the Group SHOULD automatically increase so that the group label is no longer truncated.  The group label and controls SHOULD be horizontally centered when this action occurs.  (Note in the figure below the width of the group has been expanded and the group label is no longer truncated since additional empty space was available on the right side of the Ribbon.  Also note that the controls within the group are horizontally centered.)
[image: image78.emf]

 
7. A horizontal scroll button MUST be displayed when the width of the application window is too small to display the groups at their smallest variant size.  (Note in the figure below the horizontal scroll arrow on the right side of the Ribbon.)
[image: image79.emf]


8. The horizontal scroll button MUST first appear on the right edge of the Ribbon and the right side of the Ribbon MUST be cropped.

9. Hovering over the horizontal scroll button MUST NOT cause the Ribbon to scroll.

10. Clicking the horizontal scroll button MUST page (not scroll) the Ribbon to the left. When the tab is paged all the way to the right, the horizontal scroll arrow MUST be displayed on the left side of the Ribbon.  (Note in the figure below the left side of the Ribbon is now cropped after clicking the horizontal scroll button.)
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11. The scrolled state for each tab MUST be independent of the scroll state for other tabs in the Ribbon.

12. The scrolled state MUST be remembered per tab.  Navigating from tab A to tab B, and then back to tab A, MUST NOT discard the scrolled position for tab A, regardless of how much scrolling was performed on tab B when it was displayed.  Resizing the application window SHOULD discard all scrolling position persistence. 

13. The entire Ribbon SHOULD completely disappear when the application window is less than 300 pixels wide and 250 pixels tall to provide more space for displaying the document.

14. The tabs MUST compress to fit the available space when the application window is horizontally resized using the rules outlined in the table below.   

	Step 1
	Gradually remove empty space to the right of the tabs 

	Step 2
	Gradually and uniformly remove the padding from both sides of all the tabs until the minimum padding required for displaying the tab selection and hover states is reached. 

	Step 3
	Add separator lines between tabs to assist readability. 

	Step 4
	Reduce the width of the tab with the longest name by truncating the text label.  Continue reducing the width of the largest tab (or tabs in the case of ties) until all tabs are the same width.  Tooltips MUST display the complete names of any tab whose text label is truncated. (NOTE: The minimum padding required for displaying the tab selection and hover states MUST be maintained.)

	Step 5
	Reduce the width of all core tabs equally down to a minimum of about three characters.  (NOTE: Contextual tab names SHOULD NOT be truncated until Step 6 below.)

	Step 6
	Display a horizontal scroll button.


	Step 1
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Gradually remove empty space to the right of the tabs 

	Step 2
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Gradually and uniformly remove the padding from both sides of all the tabs until the minimum padding required for displaying the tab selection and hover states is reached. 

	Step 3
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Add separator lines between tabs to assist readability. 

	Step 4
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Reduce the width of the tab with the longest name by truncating the text label.  Continue reducing the width of the largest tab (or tabs in the case of ties) until all tabs are the same width.  Tooltips MUST display the complete names of any tab whose text label is truncated. (NOTE: The minimum padding required for displaying the tab selection and hover states MUST be maintained.)

	Step 5
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Reduce the width of all core tabs equally down to a minimum of about three characters.  (NOTE: Contextual tab names SHOULD not be truncated until Step 6 below.)

	Step 6
	[image: image86.emf]


Display a horizontal scroll button.


Best Practices for Ribbon Resizing

1. Every group that contains more than one control SHOULD have a collapsed group variant defined as its smallest size variant.  

2. Groups that contain less frequently used controls SHOULD be displayed smaller before groups that contain more frequently used controls.  
3. Groups that contain controls with 16x16 icons that are better known to users SHOULD lose labels before lesser known controls when defining how the Ribbon will be resized.
Quick Access Toolbar (Required)
Controls on the Quick Access Toolbar are always available to the user, regardless of which tab is selected in the Ribbon.  For this reason, the Quick Access Toolbar is the single location in the 2007 Microsoft Office UI where controls that must always be quickly available to the user are displayed.  In addition, the Quick Access Toolbar can be customized by users to include any control to which they need frequent access in order to accommodate their specific work style.  

[image: image87.emf]


Requirements for Quick Access Toolbar

The Quick Access Toolbar requirements outlined below MUST be implemented if any of the following elements of the 2007 Microsoft Office UI are implemented: Application Menu, Ribbon, Tab, Groups, Controls, Ribbon Resizing, Visual Appearance, or Keyboard Access.  For more details see the Implementation Requirements.

Displaying the Quick Access Toolbar

1. The Quick Access Toolbar MUST be displayed above the tabs and MUST be left aligned when the application is first started.

2. The height of the Quick Access Toolbar MUST be no taller than the height required to display one 16 x 16 pixel icon at 96 dpi.  

3. The Quick Access Toolbar MUST display only one row of controls.  The Quick Access Toolbar MUST NOT display more than one row of controls.  

4. The Quick Access Toolbar MUST always be displayed, regardless of which tab is selected on the Ribbon.

5. The controls on the Quick Access Toolbar MUST NOT dynamically change when different tabs are selected in the Ribbon or when different objects are selected in the document.  

6. Controls MUST NOT automatically disappear/appear on the Quick Access Toolbar 

7. Controls on the Quick Access Toolbar MUST support the control states described in the Controls section.  For example, the Undo control MUST be displayed using the disabled state when the criteria required for its activation has not been satisfied.  (Note in the figure below the Undo control is displayed using the disabled state to indicate that it is not active.) 

[image: image88.emf]


8. The Quick Access Toolbar MUST be able to display all types of controls that can be displayed on the Ribbon.  Available controls MUST include, but need not be limited to, buttons, menus, split buttons, combo boxes, Galleries, spinner controls, and check boxes.
9. Controls displayed on the Quick Access Toolbar MUST be no larger than the height of the Quick Access Toolbar (roughly 22 pixels at 96 dpi).

10. Text labels SHOULD NOT be displayed for controls on the Quick Access Toolbar.

11. Users MUST NOT be able to resize the Quick Access Toolbar.

12. The Quick Access Toolbar MUST be displayed when the Ribbon is minimized.  (Note in the figure below the Quick Access Toolbar is still displayed when the Ribbon is minimized.)
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13. Right-clicking anywhere on the Ribbon SHOULD provide the option to “Show Quick Access Toolbar Below the Ribbon.”  (Note in the figure below the option to “Show the Quick Access Toolbar Below the Ribbon.”)
[image: image90.emf]


14. Choosing “Show Quick Access Toolbar Below the Ribbon” from the right-click menu SHOULD display the Quick Access Toolbar below the Ribbon.  (Note in the figure below the Quick Access Toolbar is displayed below the Ribbon.)
[image: image91.emf]


15. When the Quick Access Toolbar is displayed below the Ribbon, it MUST extend the entire length of the application window.  

16. When the Quick Access Toolbar is displayed below the Ribbon, its height MUST be no taller than the height required to display a single row of small controls using 16 x 16 pixel icons at 96 dpi.  

17. The Quick Access Toolbar MUST display only one row of controls when displayed below the Ribbon.  The Quick Access Toolbar MUST NOT display more than one row of controls when displayed below the Ribbon.  

18. If the Quick Access Toolbar is displayed below the Ribbon when the application is closed, then the Quick Access Toolbar MUST be displayed below the Ribbon when the application is next opened.

Customizing the Quick Access Toolbar
Users SHOULD be able to customize the Quick Access Toolbar.  The requirements outlined below are REQUIRED if Quick Access Toolbar customization is implemented.  
1. A dropdown arrow MUST be displayed on the right side of the Quick Access Toolbar.  Clicking the dropdown arrow MUST display the “Customize Quick Access Toolbar” menu.  This menu MUST provide a list of controls that users frequently add to the Quick Access Toolbar.  (Note in the figure below the options available in the Customize Quick Access Toolbar menu.)
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2. Right-clicking on any control in the Ribbon MUST provide the option to add that control to the Quick Access Toolbar.  Choosing the “Add to Quick Access Toolbar” option MUST add the control to the Quick Access Toolbar.  (Note in the figure below the “Add to Quick Access Toolbar” option displayed in the right-click menu.)
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3. Right-clicking on any group label MUST provide the option to add the entire group to the Quick Access Toolbar.  Groups that are added to the Quick Access Toolbar MUST be displayed using small button controls.  

4. Clicking on the group control displayed in the Quick Access Toolbar MUST display the entire group using the same layout as the group would require if it were collapsed in the Ribbon.  (Note in the figure below the layout for the Font group that was displayed by clicking the Font group icon on the Quick Access Toolbar.)
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Displaying Many Controls in the Quick Access Toolbar

1. When the width of the application window is too small to display all the controls in the Quick Access Toolbar on one row, a right-pointing double arrow MUST be displayed on the right side of the Quick Access Toolbar.  (Note in the figure below the right-pointing double arrow on the right side of the Quick Access Toolbar.)
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2. Clicking the right-pointing double arrow MUST display an overflow Quick Access Toolbar, which contains the controls that do not fit on the Quick Access Toolbar.  (Note in the figure below the overflow Quick Access Toolbar displayed when a user clicks the right-pointing double arrow.)
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Best Practices for the Quick Access Toolbar

1. The Quick Access Toolbar SHOULD display by default only those controls that users need most frequently when using the application.  

2. More than five controls SHOULD NOT be displayed by default on the Quick Access Toolbar. 

3. More than ten controls SHOULD NOT be displayed in the Customize Quick Access Toolbar menu.  

4. The Customize Quick Access Toolbar menu SHOULD include a “More Controls…” option that displays a dialog box where users SHOULD be able to add any control in the application to the Quick Access Toolbar.  

5. The Customize Quick Access Toolbar menu SHOULD include the “Show Below the Ribbon” option and the “Minimize the Ribbon” option.

Visual Appearance (Required) 
This section describes the visual appearance of the 2007 Microsoft Office UI.  Licensed UI MUST have an overall visual appearance that is consistent with the 2007 Microsoft Office UI, including the elements defined in this section.  

Visual appearance Requirements

The Visual Appearance requirements outlined below MUST be implemented if any of the following elements of the 2007 Microsoft Office UI are implemented: Application Menu, Ribbon, Tabs, Groups, Controls, Ribbon Resizing, Quick Access Toolbar, or Keyboard Access.  For more details see the Implementation Requirements.

Application Button

1. The Application Button MUST be round.

2. The Application Button MUST have approximately a 36-pixel diameter at 96 dpi.

3. The Application Button MUST be positioned in the upper-left corner of the application window.

4. The top half of the Application Button SHOULD be positioned in the application title bar.  (Note in the figure below the top half of the Application Button is in the application title bar.)
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5. If a custom application title bar has not been implemented, then all elements of the 2007 Microsoft Office UI MUST be shifted down.  (Note that the position of the elements in the figure below have been shifted down for an application where a custom title bar was not implemented.) 

[image: image98.emf]


6. For web-based applications, all of the REQUIRED elements of the 2007 Microsoft Office UI MUST be displayed in the browser window.  (Note that the position of the elements in the figure below are displayed in the browser window for an application developed to run in a web browser.)
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7. The Application Button MUST display the application or company logo.

8. The Application Button MUST NOT display text unless it is part of the application logo.

9. The Application Button MUST have a drop shadow to create a three-dimensional appearance. 
10. The Application Button MUST have a background gradient that is visually distinct from the background used for the Application Title Bar, the Quick Access Toolbar, and the Tabs on the Ribbon.  

11. The Application Button MUST have a background gradient that creates a shiny, glass-like visual appearance.

12. The Application Button MUST have a background gradient that creates a three-dimensional, rounded-button visual appearance. (Note that the background gradient used shown in the figure below creates a three-dimensional, rounded-button appearance for the Application Button.) 

[image: image100]
13. The Application Button SHOULD display an orange hover effect when the mouse hovers over the Application Button.  

14. The mouse hover effect displayed for the Application Button MUST have a gradient that creates the visual appearance of a protruding, rounded button when the mouse hovers over the Application Button.  (Note the hover effect shown in the Figure below for the Application Button.) 
 SHAPE  \* MERGEFORMAT 



15. The mouse hover effect displayed for the Application Button SHOULD gradually fade out (i.e., transitional fade effect) when the mouse is moved off of the Application Button.  The mouse hover effect MUST NOT immediately disappear when the mouse is moved off of the Application Button.

16. The Application Button SHOULD display a dark-orange gradient when the Application Button is pressed or when the Application Menu is open.  (Note the dark-orange gradient shown in the figure below for the pressed Application Button.)
 SHAPE  \* MERGEFORMAT 



Quick Access Toolbar

1. The Quick Access Toolbar MUST be positioned by default at the top of the application window and MUST be positioned to the right of the Application Button.

2. The Quick Access Toolbar SHOULD be positioned by default in the application title bar.

3. If a custom application title bar has not been implemented, then the Quick Access Toolbar MUST be displayed below the application title bar.  (Note the position of the Quick Access Toolbar below the title bar in an application where a custom title bar was not implemented.)
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4. The Quick Access Toolbar MUST be approximately 22 pixels tall at 96 dpi.

5. The Quick Access Toolbar MUST NOT be attached to the Application Button.  A few pixels of space (~ 6-10 pixels at 96 dpi) MUST exist between the Application Button and the Quick Access Toolbar to create the appearance of two visually distinct UI elements.

6. The Quick Access Toolbar MUST have a border.  

7. The border of the Quick Access Toolbar MUST consist of a dark and light line to create the visual appearance that the Quick Access Toolbar is carved into the Application Title Bar.  (Note in the figure below the Quick Access Toolbar appears as if it was carved into the application title bar.) 
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8. The left border of the Quick Access Toolbar MUST have a convex curve which follows the same curve as the Application Button.  The center of the circle used to create this convex curve MUST be positioned at the center of the Application Button to ensure that the convex curve follows the same curve as the Application Button.  (Note the shape of the curve on the left border of the Quick Access Toolbar in the figure below.)
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9. The right border of the Quick Access Toolbar MUST have a concave curve.  The radius of the curve MUST equal the radius of a circle positioned in the center of the application title bar.  The radius of the concave curve on the right border MUST NOT equal the radius of the convex curve on the left border.  (Note the shape of the curve on the right border of the Quick Access Toolbar in the figure below.)
[image: image106.emf]


10. The Quick Access Toolbar MUST have a slight gradient that creates a beveled visual appearance.  The gradient used for the Quick Access Toolbar MUST be different from the gradient used for the application title bar to create the visual appearance that the Quick Access Toolbar protrudes from the application title bar.  (Note in the figure below the Quick Access Toolbar has a gradient that differs from the gradient used in the application title bar and thus appears to protrude from the application title bar.)
[image: image107.emf]


11. If the application has a “Customize Quick Access Toolbar” menu, then the Quick Access Toolbar MUST have a dropdown arrow positioned on the right side of the Quick Access Toolbar.  (Note the location of the dropdown arrow on the right of the Quick Access Toolbar in the figure below.)
[image: image108.emf]


12. The dropdown arrow for the “Customize Quick Access Toolbar” menu MUST be represented using the icon in the figure below.  The icon MUST display a horizontal straight line over a down arrow.  (Note the icon displayed in the figure below.)
[image: image109.png]41




13. The dropdown arrow for the “Customize Quick Access Toolbar” menu MUST NOT be attached to the Quick Access Toolbar (i.e., within the border of the Quick Access Toolbar).  A few pixels of space (~ 5 pixels at 96 dpi) MUST exist between the Quick Access Toolbar and the dropdown arrow to create the appearance of two visually distinct UI elements.

14. The dropdown arrow for the “Customize Quick Access Toolbar” menu MUST NOT have a border and thus MUST NOT be displayed as a toolbar button.  It must have a flat visual appearance when in the normal state.

15. The dropdown arrow for the “Customize Quick Access Toolbar” menu SHOULD have three states: normal, hover, and pressed.  The table below illustrates the three dropdown arrow states for the 2007 Microsoft Office UI .  
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	Normal
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	Hover
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	Pressed


Application Title Bar

The requirements in this section are REQUIRED for all applications that license the 2007 Microsoft Office UI.  These include applications that implement a custom application title bar, applications that do not implement a custom application title, and web-based applications developed to run in a web browser.

1. A custom application title bar SHOULD be implemented for the 2007 Microsoft Office UI.  

2. If a custom application title bar is not implemented, then the application title bar requirements defined in this section MUST be displayed below the application title bar (as in the case of a client application) or at the top of the browser window (as in the case of a web-based application).  (Note in the figures below the location of the application title bar for a client application and a web-based application.)
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3. The application title bar MUST be approximately 30 pixels tall at 96 dpi.

4. The application title bar MUST have a gradient that creates a beveled visual appearance.  (Note in the figure below the gradient used to create a beveled visual appearance.)
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5. The application title bar MUST be visually distinct from the tab background.  (Note in the figure below the application title bar has a gradient, while the tab background does not.)  

[image: image116.emf]


6. The application title bar MUST have a border line at the base of the title bar to visually separate the title bar from the tab background.  (Note in the figure below the border line between the application title bar (top) and the tab background (bottom).)
[image: image117.png]



7. For applications that implement a custom title bar, a dark border line at the top of the title bar must be displayed when the application is in the restored state (i.e., not maximized).  This border MUST extend around the entire application window when the application is in the restored state.  (Note in the figure below the border line at the top of the application title bar, displayed when the application window is in the restored state.)
[image: image118.png]



8. For applications that implement a custom title bar, the document and application names MUST be displayed in the application title bar.

9. For applications that implement a custom title bar, the document and application names MUST be centered in the application title bar when no contextual tabs are displayed.

10. For applications that implement a custom title bar, the document and application names MUST be displayed using the following naming convention: “Document Name – Application Name”.

11. For applications that implement a custom title bar, the font color used to display the document name MUST be monochromatic.  The font color used to display the application name MUST be blue when the application window is active.

12. For applications that implement a custom title bar, the caption buttons displayed in the application title bar MUST be monochromatic and MUST have three states: normal, hover, and pressed.  The table below illustrates the three caption button states for the 2007 Microsoft Office UI .  
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Normal
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Hover
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Pressed


Tabs

1. Tabs MUST be displayed below the Application Title Bar and above the Ribbon.

2. The tab background MUST NOT have a gradient.  It MUST appear flat.  (Note in the figure below the tab background does not have a gradient.)
[image: image122.emf]


3. The tab background MUST be 23 pixels high at 96 dpi.

[image: image123.emf]


4. Tab names MUST NOT be vertically centered in the tab background.  Tab names MUST be slightly offset towards the bottom of the tab background.

5. The selected tab MUST have the visual appearance of a tab with rounded upper corners.  (Note in the figure below the rounded upper corners of the selected tab.)
[image: image124.emf]


6. The selected tab MUST curve at the lower corners where the tab meets the Ribbon to create the visual appearance that the tab is connected to the Ribbon.  (Note in the figure below the curve at the lower corners of the selected tab.)
[image: image125.emf]


7. The selected tab MUST have a slight shadow to create the three-dimensional visual appearance, namely that the selected tab is raised above the tab background.  (Note in the figure below the shadow on the right side of the selected tab.)
[image: image126.emf]


8. The selected tab MUST have highlights displayed on both sides of the selected tab to create the three-dimensional visual appearance of the tabs.  (Note in the figure below the white and light blue highlight lines displayed on each side of the selected tab.)
[image: image127.emf]


9. The background used for selected tabs MUST have a gradient.  The background gradient used for the Ribbon MUST extended into the selected tab.  (Note in the figure below how the background gradient for the Ribbon extends into the background for the selected tab.)
[image: image128.emf]


12. Four tab states MUST be represented.  Tab states MUST include: normal, hover, selected, and hover selected.  The table below describes the four tab states REQUIRED for the 2007 Microsoft Office UI .
	[image: image129.emf]


	Normal.  No Tab demarcation lines are drawn around the Tab.  

	[image: image130.emf]


	Hover.  The Tab is displayed as a rounded rectangle with a linear gradient that extends from the base and sides to the center.  No curve is displayed at the bottom corner of the Tab.

	[image: image131.emf]


	Selected.  The Tab is displayed with a background color that is lighter than the unselected Tabs.  The Tab is drawn with curved bottom corners.

	[image: image132.emf]


	Hover Selected.  A glow effect is created by displaying a brighter color that fades a few pixels outside and inside the Tab demarcation line.


1. Unselected tabs MUST NOT have the visual appearance of a tab.  Unselected tabs MUST have a flat visual appearance.  (Note in the figure below only the selected tab (i.e., References) has the visual appearance of a tab.  All unselected tabs do not have the visual appearance of a tab.)
[image: image133.emf]


Ribbon Background

1. The Ribbon background MUST have a gradient that creates a beveled visual appearance.  (Note in the figure below the gradient for the Ribbon background.)
[image: image134.emf]


2. The Ribbon background MUST be approximately 91 pixels tall at 96 dpi.

3. The Ribbon background MUST NOT extend to the sides of the application window.  A few pixels of space (~ 5 pixels at 96 dpi) MUST exist between the sides of the Ribbon background and the sides of the application window to create the visual appearance that the Ribbon is a distinct UI element.  (Note in the figure below the space between the sides of the Ribbon background and the application window.)
[image: image135.emf]

  

4. The Ribbon background MUST have a drop shadow to create the visual appearance that the Ribbon is floating on top of the application workspace.  (Note in the figure below the drop shadow on the Ribbon background.)
[image: image136.emf]


5. The corners of the Ribbon background MUST be rounded.  (Note the rounded corners of the Ribbon background in the figure below.)
[image: image137.emf]


Groups

1. All controls MUST be displayed in groups positioned within the Ribbon background.  

2. Groups MUST have a border to create the visual appearance of distinct UI elements.  (Note in the figure below the groups appear distinct from one another.)
[image: image138.emf]


3. Groups MUST have a border comprised of a dark and light line to create the visual appearance that the group is carved into the Ribbon background.  (Note in the figure below the use of the dark and light colored lines to create the visual appearance that the group is carved into the Ribbon background.)
[image: image139.emf]


4. The corners of the groups MUST be rounded.  (Note in the figure below the rounded group corners.)
[image: image140.emf]


5. Groups MUST have a gradient fill that is identical to the gradient used for the Ribbon background.

6. A few pixels of space (~ 2 pixels at 96 dpi) MUST exist between groups displayed on the Ribbon background to create the visual appearance of unique UI elements.  (Note in the figure below the space between each group.)
[image: image141.emf]


7. Groups MUST be evenly spaced apart on the Ribbon background.

8. The group label MUST have a background fill that is approximately 15 pixels tall at 96 dpi.

9. The background of the group label MUST extend the entire width of the group.

10. The background of the group label MUST be a visually distinct color from the gradient color used to fill the group.

11. The group label background MUST NOT have a beveled visual appearance.  Group labels MUST appear flat.  (Note in the figure below the group label background does not have a beveled visual appearance.)
[image: image142.emf]


12. Groups MUST have a mouse hover effect that makes the group appear brighter when the mouse hovers over the group.  The group over which the mouse is hovering MUST be the only group to appear brighter.  All other groups on the Ribbon MUST NOT change.

13. The mouse hover effect for Groups MUST be independent of the hover effect for controls within the group.

14. Groups MUST have two states: normal and hover.  The table below illustrates the two group states for the 2007 Microsoft Office UI .  
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	Normal.  The mouse is not over any part of the group.
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	Hover.  The mouse is over any part of the group.


15. The mouse hover effect for groups SHOULD gradually fade in (i.e., transition fade effect) when the mouse moves over the group.  The mouse hover effect SHOULD gradually fade out when the mouse moves off the group.

16. Dialog Box Launchers MUST be positioned in the lower right corner of groups when applicable.

17. Dialog Box Launchers MUST be approximately 15 x 15 pixels at 96 dpi.

18. Dialog Box Launchers MUST be represented using the icon in the figure below.  (Note the figure below the icon for a Dialog Box Launcher.)
[image: image145.emf]


19. Dialog Box Launchers MUST have a mouse hover state that is independent of the group hover state.

20. Dialog Box Launchers MUST have two states: normal and hover.  The pressed state is NOT REQUIRED.  The table below illustrates the three Dialog Box Launcher states for the 2007 Microsoft Office UI .  
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	Normal
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	Hover
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	Pressed (optional)


Scrollbars

Windows scrollbars MUST be themed on Windows XP and Windows Vista operating systems.  Windows 95 (“classic style”) scrollbars MUST NOT be displayed by default.
Custom scrollbars are NOT REQUIRED for the 2007 Microsoft Office UI.  If custom scrollbars are implemented, then the guidelines below are REQUIRED.

1. The scrollbar track MUST be approximately 17 pixels wide at 96 dpi.

2. The scrollbar track MUST be a visually distinct color from the application canvas.

3. The sides of the scrollbar track MUST have a visible border.  (Note in the figure below the border surrounding the scrollbar track.)
[image: image149.png]



4. The scrollbar track MUST have a gradient that creates the visual appearance of a depression in the scrollbar track.   (Note in the figure below the gradient creates the visual appearance of a depression in the scrollbar track.)
[image: image150.png]



5. The scrollbar thumb MUST have a gradient that creates a beveled visual appearance.  (Note in the figure below the gradient on the scrollbar thumb creates a beveled visual appearance.)
[image: image151.png]



6. The scrollbar thumb MUST be approximately 15 pixels wide at 96 dpi.

7. The scrollbar thumb MUST display four horizontal lines centered on the thumb when the thumb is greater than 12 pixels tall at 96 dpi.

8. The scrollbar thumb MUST have three states: normal, hover, and pressed.  The table below illustrates the two scrollbar thumb states for the 2007 Microsoft Office UI .
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	Normal
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	Hover
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	Pressed


9. The scrollbar arrows MUST have a flat visual appearance when in the normal state.  Scrollbar arrows MUST NOT have the visual appearance of a button when the mouse is not over the any part of the scrollbar.

10. The scrollbar arrows MUST have the visual appearance of a button when the mouse is over any part of the scrollbar track or thumb.

11. Scrollbar arrows MUST have four states: normal, track hover, button hover, and pressed.  The table below illustrates the four scrollbar arrow states for the 2007 Microsoft Office UI.  
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Normal.  To be displayed when the mouse is not over any part of the scrollbar.
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Track Hover.  To be displayed when the mouse is over any part of the scrollbar track or thumb.
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Button Hover.  To be displayed when the mouse is over the scrollbar arrow.
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Pressed.  To be displayed when the scrollbar arrow has been pressed using the left mouse button.


Status Bar

A custom status bar is NOT REQUIRED for the 2007 Microsoft Office UI.  If a custom status bar is implemented, then the guidelines below are REQUIRED.

1. The status bar MUST have a gradient that creates a beveled visual appearance.  (Note the beveled visual appearance of the status bar in the figure below.)
[image: image159.emf]


2. If the status bar both displays status information and contains view changing controls, then it MUST be divided into two sides.  The left side of the status bar MUST display status notifications.  The right side of the status bar MUST display view changing controls.

3. The two sides of the status bar MUST be visually distinct.  (Note in the figure below the difference in the gradients used for the left part of the status bar,  where notifications are displayed and the right part of the status bar, where view switching and zoom controls are displayed.)
[image: image160.emf]


4. The status bar MUST be no taller than approximately 23 pixels at 96 dpi.

5. The status bar MUST display only one row of status notifications and view switching controls.  The status bar MUST NOT display more than one row of status notifications or view switching controls.

6. The text displayed on the status bar MUST be vertically centered. 
Keyboard Access (Required)

KeyTips provide keyboard access to every control in the Ribbon.  When the ALT key is typed, KeyTips appear for all of the tabs in the Ribbon.  Typing the letter or number associated with any tab displays the KeyTips for all the controls on that tab.  Pressing the key associated with any control will then select that control and perform the associated action.  The figure below illustrates how KeyTips can be used to remove a heading style in Microsoft Word.  

1. Press ALT to make the KeyTips appear.  

[image: image161.emf]


2. Press R to select the Review tab.  

[image: image162.emf]


3. Press S to select the Spelling & Grammar button in the Proofing group.

Requirements for Keyboard Access

The Keyboard Access requirements outlined below MUST be implemented if any of the following elements of the 2007 Microsoft Office UI are implemented: Application Menu, Ribbon, Tabs, Groups, Controls, Ribbon Resizing, Quick Access Toolbar, or Visual Appearance.  For more details see the Implementation Requirements.

Displaying KeyTips

1. Keyboard focus MUST move from the document to the Ribbon when the ALT or F10 key is pressed and released.  The focus MUST NOT move until the key is released.

2. The currently displayed tab MUST be selected and MUST receive keyboard focus when the ALT or F10 key is pressed and released.  Selection and keyboard focus MUST NOT go to the first tab by default.

3. KeyTips MUST appear for all tabs, all controls on the Quick Access Toolbar and the Application Button when the ALT or F10 key is pressed and released.  (Note in the figure below the Home Tab is selected and KeyTips are displayed for all tabs as well as the controls in the Quick Access Toolbar and the Application Button.)
[image: image163.emf]


4. Pressing a key associated with a tab KeyTip MUST select that tab, move keyboard focus to that tab, and display the KeyTips for every control on that tab.  (Note in the figure below the KeyTips are displayed for every control on the Insert tab after the user types ALT, N.) 
[image: image164.emf]


5. Every control MUST have a KeyTip unique to its tab.  There MUST NOT be any duplicate KeyTips for any controls on the same tab.

6. Typing a control’s KeyTip MUST immediately perform the action associated with that control (if it is a simply button control) or move keyboard focus and selection to a non-button control so that the user can take further action (as in the case of a menu control).  

7. Keyboard focus MUST return to the document (or the location that previously had focus) immediately following the execution of any control accessed using KeyTips.  Keyboard focus MUST NOT remain in the Ribbon after the action is executed.

8. Pressing any key that is not displayed as a KeyTip when the KeyTips are displayed MUST produce the default error sound and the KeyTips MUST remain displayed.  (See Dismissing KeyTips below for exceptions to this requirement.)

9. Pressing the ESC key when the KeyTips for controls on the Ribbon are displayed MUST dismiss the KeyTips for the controls and redisplay the KeyTips for the tabs.  Keyboard focus and selection MUST be given to the currently displayed tab.  (Note in the figure below the KeyTips for the tabs are displayed for all tabs and that the Insert tab is selected after the ESC key has been pressed.)
[image: image165.emf]


10. Pressing the ESC key after a menu has been opened using KeyTips MUST close the menu and redisplay the KeyTips for all controls on the Ribbon.  Keyboard focus and selection MUST be given to the anchor for the menu that was closed.

Dismissing KeyTips

1. Pressing the ALT or F10 key when the KeyTips are displayed MUST dismiss the KeyTips and return keyboard focus to the document.

2. Pressing the ESC key when the KeyTips for the Tabs are displayed MUST immediately dismiss the KeyTips and return keyboard focus to the document.

3. Clicking anywhere on the Ribbon or the document when the KeyTips are displayed MUST dismiss the KeyTips and return keyboard focus to the document.

Keyboard Navigation

1. Pressing the ALT or F10 key MUST both display the KeyTips and move keyboard focus to the Ribbon by selecting the currently displayed tab.  If ALT or F10 is typed while focus is in the Ribbon and KeyTips are being displayed, keyboard focus MUST return to the document workspace.

2. Pressing any of the typical keyboard navigation keys (e.g., TAB, SHIFT+TAB, ARROW RIGHT, ALT+ARROW DOWN, SPACE BAR) MUST immediately dismiss the KeyTips and perform the associated in the document.  

3. When using the typical keyboard navigation keys to navigate within the Ribbon, the KeyTips MUST NOT be displayed.  

4. Using the mouse scroll wheel to navigate from one tab to another in the Ribbon MUST be disabled when the Ribbon has keyboard focus.

KeyTip Size and Positioning

1. KeyTips MUST be wide enough to fit the letter “O.”  This is the minimum width for all KeyTips.  KeyTips MUST grow wider to accommodate larger text strings.

2. KeyTips MUST be horizontally centered over each control in the Quick Access Toolbar and positioned vertically below the control so that the top two-thirds of the control is visible when the KeyTips are displayed.  (Note in the figure below the KeyTip position for controls on the Quick Access Toolbar.)
[image: image166.emf]

  

3. KeyTips for Tabs MUST be horizontally centered on each tab and positioned vertically below the tab label so that the top edge of the KeyTip touches the baseline of the text on the tab label.  (Note in the figure below the KeyTips positioned below the label for each tab.)
[image: image167.emf]

  

4. KeyTips for every control on the Ribbon MUST be vertically centered on one of four possible rows based on the following rules.  (Note in the figure below the four possible vertical positions.  They are labeled A, B, C, and D.)
[image: image168.emf]


5. KeyTips for collapsed groups MUST be displayed in row D and MUST be horizontally centered below the group.  (Note in the figure below the position of the KeyTip for the collapsed Illustrations group.)
[image: image169.emf]


6. KeyTips for Dialog Box Launchers MUST be displayed in row D and MUST be horizontally centered below the Dialog Box Launcher.  (Note in the figure below the horizontal position of the KeyTip for the Page Setup Dialog Box Launcher (i.e., “SP”).)
[image: image170.emf]


7. KeyTips for all controls that use small icons (i.e., 16x16 pixels) MUST be horizontally aligned so that their left edge is aligned with the center of the icon.  (Note in the figure below the horizontal position of the KeyTips for the controls.)
[image: image171.emf]


8. KeyTips for all controls that use large icons (i.e., 32x32 pixels) MUST be displayed in row C and horizontally centered below the icon.  (Note in the figure below the position of the KeyTips for the controls.)
[image: image172.emf]


9. KeyTips for in-Ribbon gallery controls MUST be displayed in row C and horizontally positioned so that their left edge is aligned with the center of the More Options dropdown control.  (Note in the figure below the position of the KeyTip for the Styles in-Ribbon gallery (“L”).)
[image: image173.emf]


10. KeyTips for combo boxes, list boxes, and spinner controls MUST be horizontally centered on the controls only when these controls do not have an icon.  If these controls have associated icons, then the KeyTips MUST be positioned above or below the icon.  (Note in the figure below the position of the KeyTip for the Font combo box (“FF”) as compared to the KeyTip for the Grow Font button (“FG”).)
[image: image174.emf]


11. KeyTips for check boxes MUST be horizontally positioned so that their left edge is aligned with the center of the check box.  This horizontal alignment MUST be the same as the horizontal alignment used for small icons.  (Note in the figure below the horizontal position of the KeyTips for the check boxes.) 

[image: image175.emf]


KeyTips for Collapsed Groups

1. KeyTips assigned to a control MUST NOT change when the Ribbon is resized.  (Note in the figure below the KeyTip assigned to each control never changes, even when the size of the group changes.)
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2. KeyTips MUST be displayed for collapsed groups.  (The KeyTip “ZI” is displayed for the collapsed Illustrations group in the figure below.)
[image: image179.emf]


3. Users MUST NOT be required to type the KeyTip for collapsed groups in order to access controls within a collapsed group.  The sequence of KeyTips required for every control on the Ribbon MUST NOT change when the group is collapsed.  (Typing ALT+N+P MUST launch the Insert Picture dialog when the Illustrations group is collapsed as in figure B.  Users MUST NOT be required to type ALT+N+ZI+P, but this key sequence MUST work if the user chooses to type the KeyTip for the collapsed group.)
	A
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	B
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Best PracticeS for KeyTips

1. KeyTips SHOULD appear after a 500 ms delay when the ALT key is held down, but keyboard focus SHOULD NOT move to the Ribbon and no tab SHOULD be selected until the ALT key is released.  Usability research has shown that users, who are accustomed to using keyboard shortcuts with previous versions of Microsoft Office, will often hold down the ALT key while looking at the Ribbon for additional visual information to guide their next keystroke.  (Note in the figure below the KeyTips are displayed, but that the Home tab is not selected and thus does not have keyboard focus.)
[image: image182.emf]


2. KeyTips for inactive controls SHOULD be displayed as inactive when their associated control is inactive, since KeyTips partially occlude the controls on the Ribbon.  This approach is preferable to not displaying KeyTips for inactive controls, since it provides a more consistent user experience.  (Note in the figure below the KeyTips displayed for the Cut and Copy controls are inactive.)
[image: image183.emf]


3. When typing the first character of a multi-character KeyTip, all KeyTips that do not begin with the character typed SHOULD disappear.  This approach provides users with visual feedback regarding what character they have already typed and helps users determine what valid character inputs are still available.  (Note in the figure below what happens when ALT+H+F have been typed.  The only remaining KeyTips displayed are the multi-character KeyTips that begin with the letter F.)
[image: image184.emf]


4. Pressing ESC while in the process of typing a multi-character KeyTip SHOULD immediately dismiss the KeyTips for all controls on the Ribbon and SHOULD display the KeyTips for the tabs.  This approach allows users to recover if they mistakenly press a character that is part of a two character KeyTip for a control that they do not wish to select.

Contextual Tabs (Optional)
The controls used most often in the application are always available on the Ribbon.  Some controls, however, can only be used in conjunction with a specific object selected in the document, such as a picture, chart, table, or shape.  These controls are displayed in Contextual Tabs, which only appear when a relevant object is selected.

For example, the Picture Tools Contextual Tab only appear when a picture is selected.  When a picture is not selected the picture, the Picture Tools Contextual Tab disappears.

	A
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	B
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Requirements for Contextual Tabs

Contextual Tabs are an OPTIONAL part of the 2007 Microsoft Office UI.  If Contextual Tabs are implemented, then the guidelines in this section are REQUIRED.  In addition, all nine of the REQUIRED elements MUST also be implemented if Contextual Tabs are implemented.  The nine REQUIRED elements are: Application Menu, Ribbon, Tabs, Groups, Controls, Ribbon Resizing, Quick Access Toolbar, Visual Appearance, and Keyboard Access.  For more details see the Implementation Requirements.
Selecting Contextual Tabs When Inserting a New Object

1. All requirements described in the Requirements for Tabs section also apply to Contextual Tabs.

2. If the number of controls necessary for a particular object type does not fit comfortably within a single Contextual Tab, the controls SHOULD be organized into several Contextual Tabs for that object type.  (Note in the figure below Table Tools have two Contextual Tabs, Design and Layout.)
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3. If Contextual Tabs are available for an object, they MUST be selected when a new object is inserted into the document if the new object is selected (or has keyboard focus) after being inserted.  

4. If there is more than one Contextual Tab available for the object, the leftmost Contextual Tab MUST be selected.

5. Contextual Tabs MUST behave in every way like normal Tabs once they are displayed.  See the Tabs section for more details.  (Note in the figure below the Table Tools Contextual Tabs are still available after the Home Tab has been selected.)
[image: image189.emf]


6. Contextual Tabs MUST disappear when the object is no longer selected.  

7. The leftmost (“Home”) tab MUST be selected when the object is no longer selected and the Contextual Tabs disappear.  The tab that was last selected MUST NOT be selected when the Contextual Tabs disappear.  

8. If more than one object type with associated Contextual Tabs can be selected at once, then all relevant Contextual Tabs MUST be displayed at the same time.  (Note in the figure below both the Picture Tools and Table Contextual Tabs are displayed when a picture within a table is selected.)
[image: image190.emf]


Showing Contextual Tabs After Selecting an Existing Object

1. Contextual Tabs MUST be available when the user selects an existing object in the document, but the Contextual Tabs MUST NOT become selected.  The currently selected tab MUST continue to be selected in the Ribbon.  This behavior is different from selecting the Contextual Tabs when a new object is inserted (as described in the section above). (Note in the figure below the Picture Tools Contextual Tab is available when the picture is selected in the document, but that the Picture Tools Contextual Tab is not selected.  The Home Tab continues to be selected in the Ribbon when the user selects the picture in the document.)
[image: image191.emf]


2. Contextual Tabs MUST NOT be automatically selected when an existing object is selected in the document.  Users MUST click the Contextual Tab for it to be selected.  (Note in the figure below a user has clicked on the Format Contextual Tab, so it is now selected.)
[image: image192.emf]

  

3. Contextual Tabs SHOULD be selected when a user double-clicks on an existing object in the document.

4. If a Contextual Tab is selected in the Ribbon when a user deselects and reselects the same object (or type of object) in the document without performing any other action, then the Contextual Tabs SHOULD be reselected.  This scenario is the only situation in which selecting an existing object in the document may select a Contextual Tab in the Ribbon.
Contextual Tab Labels

1. Contextual Tabs MUST have a label displayed in the application title bar.  If a custom title bar has not been implemented, then the label MUST be displayed in the space below the title bar.  See the Visual Appearance section for more information.
2. Contextual Tab labels MUST extend the entire width of the Contextual Tabs for the object.  (Note in the figure below the “Chart Tools” shading extends over all three Contextual Tabs.)
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3. Contextual Tab labels MUST be left aligned and SHOULD use the naming convention, “[Object] Tools”.

4. Contextual Tab labels MUST NOT display icons.

5. Contextual Tab labels SHOULD have a unique color associated with each object.  (Note in the figure below red is associated with the Picture Tools Contextual Tab label, while yellow is associated with the Table Tools Contextual Tab label.)
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6. Clicking on the Contextual Tab label SHOULD take the user to the first tab in that Contextual Tab set.

7. Double-clicking on the Contextual Tab label SHOULD behave in the same way that double-clicking anywhere else on the application title bar and SHOULD either restore down or maximize the application window.

Best Practices for Contextual Tabs

1. The number of Contextual Tabs displayed for a particular object in the application SHOULD vary since the number of Contextual Tabs is dependent on the number of controls associated with the relevant object.  Objects with many controls SHOULD have two or more Contextual Tabs, while objects with few controls SHOULD have only one Contextual Tab.

2. The number of Contextual Tabs for a particular object SHOULD be kept as small as possible.  Whenever possible only one Contextual Tab SHOULD be used to display all of the relevant controls for an object.  This design makes it easier for users to discover and learn the location of controls on the Contextual Tabs, since they are not required to remember on which Contextual Tab a particular control is located.  Displaying all of the relevant controls for an object on only one Contextual Tab also makes using the Contextual Tabs more efficient.    

3. Controls displayed on the core tabs SHOULD NOT be repeated on the Contextual Tabs.  For example, the Bold, Italic, and Highlight controls do not appear on both the Home Tab and the Table Tools Contextual Tabs in Microsoft Word.  The 2007 Microsoft Office UI provides additional elements to help users access the controls they need when the Contextual Tabs are displayed.  For more information on these elements see the Quick Access Toolbar and Mini Toolbar sections of this document.

Galleries (Optional)
Galleries are a new type of control found in the 2007 Microsoft Office UI.  Galleries behave similarly to menus, but the contents of Galleries are very different.  While menus provide a list of individual actions from which the user can choose, Galleries provide a visual list of results.  For example, the Margins Gallery in Microsoft Word provides a visual list of potential margin settings to choose from, rather than simply providing controls for setting the margin properties.
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Often, the visual list of results displayed in Galleries can be achieved only by combining several actions together.  The Picture Styles Gallery in the figure below shows a list of richly formatted picture results.  Each Gallery item (picture style) combines several individual actions to create the end result.
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Requirements for Galleries
Galleries are an OPTIONAL part of the 2007 Microsoft Office UI.  If Galleries are implemented, then the guidelines in this section are REQUIRED.  In addition, all nine of the REQUIRED elements MUST also be implemented if Galleries are implemented.  The nine REQUIRED elements are: Application Menu, Ribbon, Tabs, Groups, Controls, Ribbon Resizing, Quick Access Toolbar, Visual Appearance, and Keyboard Access.  For more details see the Implementation Requirements.
Displaying Galleries
1. The Ribbon MUST be able to display both dropdown and in-Ribbon Gallery controls.  (Note the dropdown Gallery in figure A and the in-Ribbon Gallery in figure B below.)  
	A
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	B
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2. Gallery controls SHOULD be able to display zoom mouse hover feedback.  The size of an item in the Gallery SHOULD be increased when the mouse hovers over that item.  (Note in figure B below the mouse was moved over the third Gallery item, which is then displayed using zoom mouse hover feedback.)
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	A
	B


3. Gallery controls MUST be able to display different content as a result of actions executed by other controls in the application.  For example, choosing a different style set from the Change Styles menu in Microsoft Word changes the contents of the items displayed in the Styles Gallery.  (Note in the figure below the items displayed in the Styles Gallery changed when a user selected a different style set from the Change Styles menu.)
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4. Each Gallery MUST be able to be displayed as either an in-Ribbon Gallery or a dropdown Gallery.  It is frequently necessary for a particular Gallery to change from being displayed as an in-Ribbon Gallery to a dropdown Gallery when the Ribbon is resized in the horizontal direction.  (Note in the figure below the WordArt Quick Styles Gallery changes from being displayed as an in-Ribbon Gallery to a dropdown Gallery when the Ribbon is resized.  See Ribbon Resizing for more information.) 
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5. Dropdown Galleries MUST be accessed just like menus.  Clicking the anchor for the dropdown Gallery displayed on the Ribbon MUST expand (i.e., dropdown) the Gallery and display its contents.  (Note in the figure below the Position dropdown Gallery has been opened by clicking on the Position control in the Ribbon.) 
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6. Clicking an item in an expanded Gallery MUST immediately execute the action associated with the item and close the Gallery. 
7. In-Ribbon Gallery controls MUST display the contents of the Gallery in the Ribbon.  Clicking an item displayed in an in-Ribbon Gallery MUST immediately execute the action associated the item.  
8. Users MUST NOT be forced to expand in-Ribbon Galleries in order to choose an item.  (Note in the figure below the items in the Picture Styles in-Ribbon Gallery can be clicked without first opening the Gallery.)
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9. In-Ribbon Gallery controls MUST be displayed in a unique container within each group so that other controls can also be displayed in the group.  (Note in the figure below the Shape Styles Gallery is displayed in a unique Gallery container within the group and that other controls, such as Shape Fill, Shape Outline, and Shape Effects are also displayed within the same group.)  
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10. In-Ribbon Gallery controls MUST extend the entire height of the group from the top of the group label to the base of the tabs.  (Note in the figure below the height of the in-Ribbon Gallery controls for Layouts and SmartArt styles.) 
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11. In-Ribbon Gallery controls MUST NOT display partial items.
12. In-Ribbon Gallery controls MUST NOT display category headings for items in the Gallery.  (Note in figure A below the category headings “No Transition,” “Fades and Dissolves,” and “Wipes” are not displayed when the Gallery is displayed in-Ribbon.  These category headings are only displayed when the Gallery is expanded, as in figure B.)
	A
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	B
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In-Ribbon Gallery Navigation Arrows
1. In-Ribbon Gallery controls MUST have three navigation arrows:  two arrows for paging up and down within the Gallery and one more arrow for expanding the entire Gallery by dropping it down like a menu.  (Note in the figure below the three in-Ribbon Gallery navigation arrows.)
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2. In-Ribbon Gallery navigation arrows MUST be positioned on the right side of the gallery container.
3. In-Ribbon Gallery navigation arrows MUST be vertically stacked so that the up arrow is positioned at the top, the down arrow is positioned in the middle, and the dropdown arrow is positioned at the bottom.
4. Four in-Ribbon Gallery navigation arrow states MUST be represented.  These states SHOULD include: disabled, active, hover, and pressed.  The table below describes the four in-Ribbon Gallery navigation arrow states for the 2007 Microsoft Office UI.
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	Disabled.
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	Active.
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	Hover.
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	Pressed.


5.  Clicking the down arrow MUST page down and display the next full row of items in the Gallery.  Clicking on the up arrow MUST page up and display the previous full row of items in the Gallery.  The Gallery MUST NOT expand (i.e., dropdown) when either the up or down arrows are clicked.
Displaying Expanded In-Ribbon Galleries
1. Clicking the dropdown arrow MUST expand the entire gallery by dropping it down like a menu.  (Note in the figure below the dropdown arrow located in the bottom right corner of the in-Ribbon Gallery control.)
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2. The top row of the expanded in-Ribbon Gallery MUST be displayed over the Ribbon.  (Note in the figure below the expanded in-Ribbon Gallery is positioned over top of the Ribbon.)
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3. Expanded in-Ribbon Galleries MUST be locked into position.  Users MUST NOT be able to drag or move the expanded in-Ribbon Galleries.
4. Expanded in-Ribbon Galleries MUST be at least as wide as the width of the in-Ribbon Gallery before the Gallery was expanded so that the entire in-Ribbon Gallery control is occluded.  
5. Expanded in-Ribbon Galleries MUST NOT default to be taller than the height required to display all of the items in the Gallery.  There MUST NOT be additional empty white space at the bottom of the expanded Gallery.
6. Expanded in-Ribbon Galleries MUST NOT default to a height greater than two-thirds the height of the display monitor to ensure that the expanded Gallery does not completely occlude the document.
7. Expanded in-Ribbon Galleries MUST display a scrollbar with scroll arrows on the right when more items are in the Gallery than can be displayed at the current height.

8. Expanded in-Ribbon Galleries MUST NOT display horizontal scroll bars.
Resizing Expanded In-Ribbon Galleries
1. Both dropdown and in-Ribbon Galleries SHOULD be resizable.

2. Expanded in-Ribbon Galleries SHOULD display resize handles in the bottom right corner of the Gallery to indicate when the Gallery can be resized.
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3. Users MUST NOT be able to resize an expanded in-Ribbon Gallery to be narrower than the width of the in-Ribbon Gallery before the Gallery was expanded.
4. Users SHOULD be able to resize an expanded in-Ribbon Gallery to be wider than the width of the in-Ribbon Gallery.
Gallery Filters

Galleries SHOULD be able to host Gallery filters.  The requirements outlined below are REQUIRED if a Gallery filter is implemented.

1. Gallery filters MUST be positioned at the top of the expanded Gallery.  (Note in the figure below the option “All” with a dropdown arrow at the top of the expanded Gallery.)
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2. Gallery filters MUST NOT be displayed when the gallery is displayed as an in-Ribbon Gallery.  The Gallery filters MUST be displayed only when the in-Ribbon Gallery is expanded.

3. A dropdown arrow MUST be positioned to the right of the gallery filter label.

4. The background color used for Gallery filter labels MUST be a visually distinct color from the background used for Gallery category headings.

5. The background color used for Gallery filter labels MUST extended the entire width of the Gallery.

6. Gallery filter labels MUST display mouse hover feedback when the mouse is over the label.  (Note in the figure below both the text string and the dropdown arrow are highlighted in a different color than their normal state to give mouse hover feedback.)
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7. Clicking the Gallery filter label MUST display a menu with the categories by which the user can filter the items displayed in the Gallery.  (Note in the figure below the gallery filter label has been clicked and the gallery filter menu options are displayed.)
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8. Clicking a filter option for Gallery MUST dismiss the filter menu and refresh the expanded Gallery to display only those Gallery items in the chosen category.
9. When clicking a filter changes the number of displayed items, the size of the expanded Gallery MUST reduce or expand to fit the new number, unless the user has previously resized the expanded Gallery (in which case the size MUST NOT change).

10. The text string used for the Gallery filter label MUST change to display the current filter category.  (Note in the figure below the Gallery filter label has changed from “All” to “List Library.”)
[image: image222.emf]


Mini Toolbar (Optional)
The Mini Toolbar appears next to the mouse cursor when you select text with the mouse.  It provides quick and efficient access to the most useful text formatting controls. 

When a user selects text with the mouse (1 in the figure below), the Mini Toolbar appears and is translucent (2 in the figure below).  When the mouse cursor moves toward the Mini Toolbar, it becomes opaque, and the controls on the Mini Toolbar become clickable.  When the mouse cursor moves away from the Mini Toolbar or another action (such as typing) is performed, the Mini Toolbar disappears.
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Requirements for Mini Toolbar
The Mini Toolbar is an OPTIONAL part of the 2007 Microsoft Office UI.  If the Mini Toolbar is implemented, then the guidelines in this section are REQUIRED.  In addition, all nine of the REQUIRED elements MUST also be implemented if the Mini Toolbar is implemented.  The nine REQUIRED elements include: Application Menu, Ribbon, Tabs, Groups, Controls, Ribbon Resizing, Quick Access Toolbar, Visual Appearance, and Keyboard Access.  For more details see the Implementation Requirements.
Displaying the Mini Toolbar
1. The Mini Toolbar MUST be displayed when text is selected with the mouse.
2. The Mini Toolbar MUST NOT be displayed when text is selected with the keyboard.
3. The Mini Toolbar MUST be displayed so that the bottom left corner is approximately 11 pixels at 96 dpi  above the position of the mouse pointer when the left mouse button is released following text selection (i.e., mouse up).  This metric is given in pixels at 96 dpi and MUST be scaled appropriately for other dpi settings.  (Note in the figure below the position of the Mini Toolbar.)
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4. The Mini Toolbar MUST be displayed relative to the position of the mouse when the left mouse button is released following text selection.  The Mini Toolbar MUST NOT be displayed relative to the position of the text selection.  Therefore, the Mini Toolbar may be displayed over selected text.  (Note in the figure below the Mini Toolbar is displayed over text that was selected by dragging from upper left to lower right.)
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5. For discontiguous selections of text, the Mini Toolbar MUST be displayed approximately 11 pixels above the position of the mouse pointer when the CTRL key is released, rather than when the left mouse button is released.
6. The Mini Toolbar MUST NOT be displayed off screen.  The Mini-Toolbar MUST be adjusted as little as possible so that all edges are always displayed on screen.
7. The Mini Toolbar MAY be displayed over the Ribbon or task panes.
8. The Mini Toolbar May be displayed outside the application window when the window is not maximized. 
9. The Mini Toolbar MUST be mostly invisible when it is initially displayed.  
10. The Mini Toolbar MUST be completely opaque (i.e., translucency = 0) when the mouse pointer is moved over the Mini Toolbar.
11. The Mini Toolbar MUST become gradually less translucent when the mouse pointer is moved closer.  The Mini Toolbar MUST become gradually more translucent when the mouse pointer is moved away.  (The figure below provides an example of how the translucency for the Mini Toolbar changes with respect to the position of the mouse pointer.)
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	Mouse pointer far from the Mini Toolbar. (Translucency roughly 75%)
↓
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	Mouse pointer closer to the Mini Toolbar.
(Translucency roughly 25%)
↓
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	Mouse pointer close to the Mini Toolbar.
(Translucency roughly 5%)
↓
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	Mouse pointer over the Mini Toolbar
(Translucency 0 %)


12. Changes in translucency for the Mini Toolbar MUST occur linearly over a range of 11 pixels from the edge of the Mini Toolbar.  
Dismissing the Mini Toolbar
1. The Mini Toolbar MUST be completely dismissed and MUST NOT reappear for a particular instance of selected text when the mouse pointer is moved more than 44 pixels away from the closest edge of the Mini Toolbar, if the user has never hovered over the Mini Toolbar.  

2. If the mouse pointer has crossed over the edge of the Mini Toolbar, then the distance used to determine when to completely dismiss the Mini Toolbar MUST change from 44 pixels to 176 pixels.

3. The distance variable used to determine when to completely dismiss the Mini Toolbar for a particular instance of selected text MUST be independent of the distance variable used to determine changes in translucency for the Mini Toolbar.  

4. If the mouse pointer has not crossed over the edge of the Mini Toolbar (which has not become completely opaque), then the distance used to determine changes in translucency MUST change from 11 pixels to 22 pixels.  In other words, the distance from the edge of the Mini Toolbar that causes it to become completely transparent is greater than the distance the mouse had to move to make it opaque.

5. If the mouse pointer has crossed over the edge of the Mini Toolbar and made it opaque, then the distance used to determine changes in translucency MUST change from 11 pixels to 44 pixels.

6. The Mini Toolbar MUST be dismissed and text selection MUST be preserved when the user types ESC on the keyboard.

7. The Mini Toolbar MUST be dismissed and text selection MUST be preserved when users scroll with the mouse scroll wheel.

8. The Mini Toolbar MUST be completely dismissed when users type any key or click anywhere outside the Mini Toolbar and selection should behave as it would if the user clicked there without having seen the Mini Toolbar.
Controls Displayed on the Mini Toolbar
1. Controls displayed on the Mini Toolbar MUST display the same mouse states that are represented for the control when it is displayed on the Ribbon.
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	Normal.
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	Hover. 
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	Pressed.
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	Selected.
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	Hover Selected.


2. Controls displayed on the Mini Toolbar MUST NOT have tooltips.
3. Controls displayed on the Mini Toolbar MUST behave in the same way as when they are displayed on the Ribbon.  For example, clicking on split buttons or combo boxes MUST drop a menu as they do when they are displayed on the Ribbon.  (Note in the figure below the split button for Font Color still drops a menu when clicked from the Mini Toolbar.)
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4. The Mini Toolbar MUST remain displayed after a control is selected.  The action for the control MUST be immediately executed, but the Mini Toolbar MUST NOT be dismissed.  The Mini Toolbar MUST remain displayed so that additional controls may be chosen for a particular instance of selected text.  If the mouse pointer is moved 176 pixels away then the Mini Toolbar MUST be dismissed.

5. Combo boxes displayed in the Mini Toolbar MUST have the same keyboard behaviors as combo boxes displayed in the Ribbon.  You MUST be able to click inside a combo box and type a value. 
6. When a selection is made from a combo box menu displayed in the Mini Toolbar, the command MUST be immediately executed and the Mini Toolbar MUST NOT disappear, even if the mouse pointer is farther than 176 pixels away from the Mini Toolbar.  (Note in the figure below the Mini Toolbar is still displayed even though the distance of the mouse, hovering over the Arial font option, is greater than 176 pixels from the Mini Toolbar.)
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Displaying the Mini Toolbar with Context Menus
1. If the user right-clicks in a place where selecting would cause the Mini Toolbar to be displayed, then the Mini Toolbar MUST be displayed along with the context menu, but in a separate window.

2. The Mini Toolbar MUST be displayed above the context menu when the menu is displayed down from the position of the right-click.  The Mini Toolbar MUST be displayed below the context menu when the menu is displayed up from the position of the right-click.  (Note in the figure below the two different locations where the Mini Toolbar is displayed.)
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3. The position of the context menu MUST NOT change when the Mini Toolbar is displayed.  The Mini Toolbar is simply displayed above or below the contextual menu.
4. A 15 pixel gap (at 96 dpi) MUST exist between the context menu and the Mini Toolbar.
5. The left edge of the Mini Toolbar MUST be aligned with the left edge of the context menu.

6. The minimum width of context menus where the Mini Toolbar is displayed MUST be at least as wide as the Mini Toolbar.  
7. The Mini Toolbar MUST NOT be displayed with a context menu that is narrower than the Mini Toolbar.  
8. The Mini Toolbar MUST be opaque when displayed with the context menu.  The Mini Toolbar MUST NOT be translucent when displayed with the context menu, regardless of the position of the mouse pointer or keyboard focus.
9. The Mini Toolbar MUST NOT be displayed when the context menu is displayed via typing SHIFT+F10 or by typing the context menu key on the keyboard.
10. The Mini Toolbar MUST be dismissed using the same rules as the context menu uses.  When the context menu is dismissed, the Mini Toolbar MUST be dismissed.

11. Users MUST NOT be able to use the keyboard to navigate from the context menu to the Mini Toolbar.
12. When a control displayed on the Mini Toolbar is used, the context menu MUST disappear and the Mini Toolbar MUST remain displayed to allow for the use of other controls on the Mini Toolbar.  Once the context menu disappears, the Mini Toolbar MUST behave in the same way as it would for selected text.

13. The ability to turn off the Mini Toolbar SHOULD be provided in the application’s options.  This option SHOULD NOT turn off the Mini Toolbar displayed with context menus.  The Mini Toolbar SHOULD always be displayed with context menus.
ScreenTips (Optional)
ScreenTips help bridge the gap between the user interface and the Help system.  ScreenTips appear when the mouse pointer hovers over a control in the 2007 Microsoft Office UI.  ScreenTips display the name of the control, the keyboard shortcut for the control, and a brief description of how to use the control.

Some ScreenTips in the 2007 Microsoft Office UI also provide F1 support, which opens Microsoft Office Help and takes the user directly to the related Help topic for the control whose ScreenTip was displayed when the F1 button was pressed.
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Requirements for ScreenTips
ScreenTips are an OPTIONAL part of the 2007 Microsoft Office UI.  If ScreenTips are implemented, then the guidelines in this section are REQUIRED.  In addition, all nine of the REQUIRED elements MUST also be implemented if ScreenTips are implemented.  The nine REQUIRED elements are: Application Menu, Ribbon, Tabs, Groups, Controls, Ribbon Resizing, Quick Access Toolbar, Visual Appearance, and Keyboard Access.  For more details see the Implementation Requirements.
Displaying ScreenTips
1. All Controls on the Ribbon MUST display a ScreenTip when the mouse pointer hovers over a control for more than 900 ms.
2. ScreenTips SHOULD have a 20 second timeout that automatically causes them to disappear.
3. ScreenTips MUST disappear when the control is clicked with the mouse or when any key is pressed on the keyboard.
4. ScreenTips for controls on the Ribbon MUST NOT be displayed over the Ribbon.  ScreenTips MUST be displayed 5 pixels (at 96 dpi) below the Ribbon, whether the control is positioned at the top or bottom of the Ribbon.  (Note that the vertical position of the ScreenTip is the same for both the Breaks control (figure A below) and the Hyphenation control (figure B) even though each control is displayed on a different row in the Ribbon.)
	Figure A
	Figure B
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5. ScreenTips MUST be aligned with the left edge of the control with which they are associated.  (Note in the figure below the alignment of the ScreenTip for the Underline control.)
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6. ScreenTips MUST be able to display an image along with descriptive text that describes the control.  
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7. ScreenTips MUST be displayed at one of two possible fixed-width sizes, one for ScreenTips that contain an image (318 pixels wide at 96 dpi) and one for ScreenTips that do not contain an image (210 pixels at 96 dpi).  

8. The width of ScreenTips MUST NOT change as a result of the amount of text displayed on the ScreenTip.  
9. ScreenTips MUST be displayed at a minimum height (50 pixels at 96 dpi).  The height of ScreenTips may increase as a result of the amount of text displayed on the ScreenTip.
10. ScreenTips MUST be displayed with a background color that is different from the background color used for the Ribbon and the document so that the ScreenTips are conspicuous.  
11. ScreenTips MUST be able to display different content for the same control based on whether it is active or inactive.  

Best Practices for ScreenTips
1. ScreenTips SHOULD display the name of the control and the keyboard shortcut for the control (if one exists).
2. ScreenTips SHOULD display a brief description of the control when appropriate.
3. The name of the control and the keyboard shortcut for the control SHOULD be left aligned at the top of the ScreenTip and SHOULD be displayed using bold font. 
4. The keyboard shortcut for the control SHOULD be displayed to the right of the control name (on the same line) and SHOULD be displayed within parentheses using bold font. 
5. ScreenTips with a description SHOULD display the description using normal font.  The description for the control SHOULD be displayed 14 pixels (at 96 dpi) below the name of the control and 8 pixels (at 96 dpi) indented to the right of the control name.  (Note in the figure below the location of the descriptive text on the ScreenTip.)
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6. ScreenTips SHOULD include a text label at the bottom of the ScreenTip that reads, “Press F1 for more help.”  Pressing the F1 key when the ScreenTip is displayed SHOULD open Help and take the user to the Help topic that describes the control.  (Note in the figure below the text that reads, “Press F1 for more help.”)
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7. The information displayed on ScreenTips over inactive controls SHOULD help users understand why the control is inactive and what steps they need to take in order to activate the control.  (Note in the figure below the ScreenTip explains to the user how to take full advantage of the functionality provided by the application.)
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